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1.0 INTRODUCTION 
 
Welcome to personalized printing with Adobe ® Acrobat ® forms and ARTS PDF 
Variform Lite™ from ARTS PDF™. 
 
ARTS PDF Variform Lite extends Acrobat forms and overcomes several restrictions that 
limit their usability. 
 
With Acrobat versions to date, the rendering of text fields has been limited to a small set 
of fonts (Courier, Times, Helvetica, Symbol, and Zapf Dingbats). This effectively 
eliminates the use of Acrobat forms for a number of popular appearance-critical 
applications, such as, mail merge, invitations, certificates, etc, or where organization-
identity fonts are required. 
 
But perhaps a greater restriction is that Acrobat forms were designed for web server-
based applications. So for anyone to consider an Acrobat forms application, this 
immediately brings to mind a significant “forms project” and trying to enlist the help of IT 
or MIS department. Such prospects are either beyond the reach of most individuals, 
difficult to implement given organizational constraints, beyond available budgets, or 
achievable in the next decade. 
 
ARTS PDF believes that there are literally millions of private databases. These exist in 
the form of word processing documents, spreadsheet files, PC databases, and even 
custom query results from large databases. These all share the common trait that they 
can be represented in a simple delimited text file on a personal computer. 
 
Adobe’s Acrobat forms plug-in allows virtually any PDF document created from virtually 
any desktop application to be turned into a variable data form.  But please remember 
that the term “form” is used in the general sense. It can include multi-line blocks of text.  
The definition is only restricted by our imaginations. 
 
Combining the freedom of independent Acrobat forms design and ARTS PDF Variform 
Lite’s local access means that general usage of Acrobat forms can be extended to 
individuals, small or home offices, small businesses, self-employed professionals, 
branch offices, corporate departments, membership organizations, etc. 
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1.1 Product Highlights 
 
ARTS PDF Variform Lite provides a set of tools for managing and printing data from 
external files to PDF forms documents. With ARTS PDF Variform Lite, you can control 
the fonts used in printing forms, specify the range of records from a data file to be 
printed and extract form field names from an existing Acrobat form document to an 
external file. 
 
Data files can be created from any application or database which is capable of exporting 
records to a delimited file. ARTS PDF Variform Lite supports tab, comma, semicolon or 
space-delimited formats. 
 
Any Acrobat form document using form fields and appropriate security settings can be 
used as a merge document. 
 
Merged data can be printed to any PostScript printer or to a PostScript file. New, merged 
PDF documents can be created by ARTS PDF Variform Lite by printing directly to the 
Acrobat Distiller printer or by printing to a PostScript file and then using Acrobat Distiller.  
Subsequently, these merged PDF documents may be printed on any PCL or PostScript 
printer. 
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2.0 ARTS PDF VARIFORM LITE SETUP 
 

2.1 System Requirements 
 

2.1.1 Macintosh 
• PowerMacintosh G3 or G4  
• System 9.2 or 10.2 or higher  
• Adobe ® Acrobat ® 5.05 or higher  

 

2.1.2 Windows 
• PC with Pentium processor 
• Windows ® NT 4.0, Windows ® 2000 or Windows ® XP  
• Adobe ® Acrobat ® 5.05 or higher 

 
 
CAUTION: Any folders or files which are created during installation are required by ARTS PDF 
Variform Lite. If you rename, move, or delete these folders the product will not work correctly. 

2.2 Installation 
 

In addition to the User’s Guide, the ARTS PDF Variform Lite folder contains other 
support files needed by ARTS PDF Variform Lite. The installation CD also has some 
sample PDF documents that demonstrate different data merge applications. The sample 
files are not installed to your hard disk. 
  
ARTS PDF Variform Lite will use and PostScript or TrueType fonts installed on the 
system for font selection. 
 

To validate the software’s registration and/or to view the installation status, open Acrobat 
and view the “About Plug-Ins” box at the bottom of the Acrobat Help pulldown menu for 
“ARTS PDF Variform Lite...”.  The word “***Unregistered***” appears in the ARTS PDF 
Variform Lite “About” box when the version is not fully licensed. To validate your license, 
click on the “Register...” button, and then enter the serial number provided by ARTS 
PDF.   
 
To deactivate the plug-in, move it and the ARTS PDF Variform Lite folder out of the 
Acrobat Plug-Ins folder before launching Acrobat. 

2.2.1 Demo Mode 
 
When ARTS PDF Variform Lite is in demo mode it will print DEMO on all output. 
Otherwise, the demo version of ARTS PDF Variform Lite is identical to the licensed 
version. 
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3.0 USING ARTS PDF VARIFORM LITE 
 
To use the software, select “ARTS PDF Variform Lite” from the Acrobat “Tools” pulldown 
menu.   Alternatively, you can launch ARTS PDF Variform Lite using the tool button on 
the Acrobat toolbar. ARTS PDF Variform Lite will then display its print dialog box. 
 

 Note: ARTS PDF Variform Lite must temporarily modify a PDF document during the data 
merge/print operation. For this reason it cannot be used with PDF documents which have 
security settings applied. In order to use ARTS PDF Variform Lite it will be necessary to 
remove document security before attempting to merge a data file. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 1: The ARTS PDF Variform Plus menu 
 

Figure 2: The ARTS PDF Variform Plus toolbar 

Export Field Names 
Variform Lite Setup 

Variform Watched Folder 
Variform Print 
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4.0 ACROBAT FORM FIELDS 
 
There are currently seven different types of form fields which can be created in Acrobat 
4. These are described briefly below. Due to the nature of certain form field types, ARTS 
PDF Variform Lite will only merge data into Combo boxes or Text boxes. If other field 
types are used with ARTS PDF Variform Lite the resulting output for those fields will be 
blank. If there is a need to include items which would normally be indicated in a Check 
Box, the user should design the form using a Text box and put the appropriate character 
for “checked” in the data file. As an example, design the form to use the Zapf Dingbats 
font and put the numeral 3 or 4 in the data file for this field. This will cause a � or � to 
appear in the merged file. Consult the Acrobat documentation (Help -> Acrobat Guide) 
for more information on creating Acrobat forms. 

 

• Buttons allow you to activate a series of actions. 

• Check boxes allow your user to make multiple selections from a group of items. 

• Combo boxes allow you to specify a list of items that appear in a pop-up menu. 

• List boxes allow the user to create a list of items in a form field that displays all 
the time. Text boxes allow you to create a field into which you can enter text 
using the keyboard. 

• Radio buttons allow your user to select one item from the displayed options. 

• Digital signature fields allow you to create a form field that your user can then 
fill in with a signature and a printable representation. This field can be set to lock 
other fields after it is signed. 

• Text boxes allow you to create a field into which you can enter text using the 
keyboard. 
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4.1 Appearance 
 

When creating form fields, Acrobat allows the user to define a number of items affecting 
the field’s appearance. These include such things as border color, width, and style, 
background color, text color, font and font size. ARTS PDF Variform Lite supports all of 
these choices and the output from ARTS PDF Variform Lite will include them. The user 
may also choose whether the form field is read only and/or required. Neither of these 
has any effect on ARTS PDF Variform Lite’s ability to merge and print the data. Finally, 
the user has several choices about the form field’s visibility. The only choice here which 
has any effect on ARTS PDF Variform Lite is “Visible but doesn’t print”. Although the 
data will be merged, for obvious reasons, it will not appear in the output from ARTS PDF 
Variform Lite. 

4.2 Options 
 

Acrobat allows the user to enter a default value for a form field, set the text alignment, 
choose whether the field supports multi-line input, limit the number of characters which 
can be entered in a field, treat the field as a password. Although ARTS PDF Variform 
Lite supports all of these options, the user should exercise care when implementing a 
limit on the number of characters or the password option. If the data to be merged 
exceeds the character limit for the field, ARTS PDF Variform Lite will still print it, but the 
data will be truncated. Selecting the password option causes data for that field to be 
displayed as “****” and ARTS PDF Variform Lite will print it as such. 

4.3 Actions 
 

The user may define actions which occur when certain events take place. This is 
primarily related to manual entries in forms and has no effect on ARTS PDF Variform 
Lite’s ability to merge and/or print. 

4.4 Format 
 

Acrobat allows the user to select from predefined formats or create custom formats for 
the data to be entered into a field. Although ARTS PDF Variform Lite supports the use of 
these formats, care should be exercised when defining them. If the format for a field is 
different than the format of the data in a file to be merged, ARTS PDF Variform Lite will 
report an error whenever it encounters a data entry which does not match the form 
field’s defined format. This can be overridden by selecting “Ignore Field Formats” in 
ARTS PDF Variform Lite’s Preferences. 
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4.5 Validate 
 

When a field’s format is numeric, Acrobat allows for validation of the data entry. As with 
the Format option (above), ARTS PDF Variform Lite supports the use of validations, but 
care should be exercised when defining them. If the data in a file to be merged does not 
meet the validation criteria, ARTS PDF Variform Lite will report an error whenever it 
encounters a data entry which does not meet the form field’s defined validation 
requirement. This cannot be overridden by ARTS PDF Variform Lite. 

4.6 Calculate 
 

When form fields have a numeric format, Acrobat allows the user to specify calculations 
to be performed on two or more such fields. ARTS PDF Variform Lite supports the use of 
calculations and the merged output will include the results of any calculations defined in 
the form. 

 
 Note: In order for calculations to merge correctly you may not use a custom font for the field 

which contains the calculations. This is because ARTS PDF Variform Lite must put additional 
data for the custom font in the field when performing a merge. 
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5.0 PREFERENCES 
 

 
The preferences for ARTS PDF Variform Lite can be set using the standard Acrobat 
method of File -> Preferences -> ARTS PDF Variform Lite. After making changes in this 
window click “OK” to make them permanent. Clicking “Cancel” will return the preferences 
to the last values stored. 

5.1 Default Data File Folder 
 
This determines the default path where 
ARTS PDF Variform Lite will look for data 
files when it is launched. The path may be 
entered manually, or by using the “Set...” 
button to browse to select a folder. 
 
 
 
 
 
 
 

5.2 Embed Custom Fonts 
 
Selecting “Embed Custom Fonts” here will embed any custom fonts in the saved PDF, 
otherwise they are not embedded. If no custom fonts are selected using the “Select 
Fonts” function then this setting has no effect. There are two cases which can cause 
fonts to be embedded. First, selecting custom fonts, then saving the file will embed 
them. Second, printing a file with custom fonts, then closing the file without saving it will 
cause Acrobat to prompt the user to save the file. Answering “yes” will save and embed 
the fonts. Answering “no” will save the file without embedding the fonts. 

5.3 Ignore Field Formats 
 
This function allows ARTS PDF Variform Lite to ignore all Acrobat form field formats 
when merging data. This may permit the successful merging of data when the form field 
format would otherwise cause an incorrect or no data merge. 
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6.0 SETUP 
 
 
The ARTS PDF Variform Lite Setup window allows the user to select all of the 
parameters necessary to merge an external file with the Acrobat form.  

 

 
 

6.1 Data File 
This box contains the path and file name of the data file to be used for merging. The 
information may be typed in manually, or the user can use the “Set...” button to browse 
the hard disk to select a file. The initial default for this field is blank, or no entry. The 
default path may be changed by setting the preferences for ARTS PDF Variform Lite.  

 
 Note: Data files must have the field names in the first line of the file. Also the field names 

must exactly match the names of the Acrobat form fields. 
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6.2 Delimiter 
 
This drop-down list is used to select the type of delimiter used in the data file. Valid 
delimiters are Tab, Comma, Semicolon, or Space. If the delimiter selected does not 
match what ARTS PDF Variform Lite finds in the data file, a warning message will 
appear and printing will not be allowed until the correct choice is made. 
 

6.3 Field Highlighting Options 
 
•  Highlighting 

There are three options for highlighting fields in the output. 
 

 Note: ‘No Highlighting’ is the default. ARTS PDF Variform Lite will not apply any highlighting 
when merging data. 

 
 Highlight Blank Fields:  

Choosing this option will cause any field which does not contain data from the data 
file to be highlighted in the output. 

 
 Highlight Fields Containing:  

This allows the user to specify a text string that will cause highlighting in the output if 
the data file contains that text. 

 

6.4 Custom Fonts 
 
The “Custom Fonts” section of the ARTS PDF Variform Lite Setup will display all of the 
Field Names from the current PDF, the font name assigned to that form field by Acrobat 
and the custom font, if any, to be used when printing the document using ARTS PDF 
Variform Lite. Custom Fonts may be selected in one of two ways. Double-clicking on an 
entry in the list will launch the “Select Font” window. Selecting an entry, then clicking on 
“Set Font...” will also launch “Select Font...” To enable the use of custom fonts when 
printing the box next to the field name must be “checked”. To turn off the use of one or 
more custom fonts simply uncheck the box(es). Likewise, to re-enable check the  
box(es) again. 
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The Select Font window will display all of the fonts currently installed on the system. This 
includes both PostScript and TrueType fonts. To change the fonts assigned to a form 
field, select the font name from the list and click “OK”. To return to the ARTS PDF 
Variform Lite Setup Dialog without making a change, click “Cancel”. 
 
 

 
 
 

 Note: If custom fonts are selected and/or used Acrobat will prompt the user to save the file 
when closing it. If the file is saved, the custom font selections will be stored in the PDF and 
will appear the next time the document is opened. Also see Setting Preferences for 
information on embedding custom fonts in the PDF. 
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7.0 PRINT 
 

7.1 Print Records: 
 
The user can choose to print all of the data records in the source file or a selected range. 
ARTS PDF Variform Lite will automatically parse the data file to determine the total 
number of records. The result will be displayed in the “to” field. 
 
 

7.2 Page Range 
 
If a form has more than 1 page, this 
section of the Print window can be used 
to specify whether all pages, a specific 
range of pages, or even and/or odd 
pages are to be merged.  
 
 

7.3 Print to 
 
This section of the window allows the 
user to select a Printer or File as the 
output destination. The choices listed for 
printer will be all of the printers currently 
installed on the system where ARTS 
PDF Variform Lite is being used. 

 
If “File” is selected the user may specify 
a destination folder for the output. The 
“Folder” name may be entered manually 
by typing in the complete path, or by using the “Set...” button to browse for one.  
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7.4 File Options 
 
“Single File” is a checkbox which indicates whether the output should be a separate 
PostScript file for each record in the data file, or one consolidated file. 

 
The “File Name” may be entered manually. Entry of a file name will be active only when 
“Single File” is ON (checked). The initial default file name will be the same as the name 
of the PDF document being used for this job.  
 
Caution: If “Single File” is turned OFF and the user does not select “Form Field” then 
ARTS PDF Variform Lite will create multiple PostScript files using the file name currently 
displayed in the “File Name” field and add a numerical suffix to each file. For example, if 
the file name shown was “myform.ps” and there are 3 records to be merged the resulting 
file names will be myform0.ps, myform1.ps, and myform2.ps. 

 
“Form Field” will become active only when “Single File” is OFF (unchecked). This allows 
the user to pick from a list of the form field names in the PDF. The data for that field will 
be used as the file name. For example if the user picks “Last Name” from the list of 
fields, each PostScript file will use the data for that field to name the PostScript file. So, if 
there are 3 records with the names Jones, Anderson, and Smith, the PostScript file 
names will be Jones.ps, Anderson.ps, and Smith.ps. This is particularly useful if the 
PostScript files are to be later turned back into PDF documents using Acrobat Distiller 
which would create be Jones.pdf, Anderson.pdf, and Smith.pdf documents. 

 
 Note: The output from ARTS PDF Variform Lite is PostScript. This is true whether printing to 

a printer or to a file. To print to a non-PostScript printer, first make a merged PDF then use 
Acrobat’s print function to output the merged file to other types of printers. 
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8.0 EXPORT FIELD NAMES 
 

 
The “Export Field Names” window can be accessed by selecting “Export Field Names” 

from the Acrobat “Tools” pulldown menu, or by clicking on the   button on the 
Acrobat toolbar. 
 
In order to correctly merge data with 
an Acrobat form, ARTS PDF Variform 
Lite requires that the field names in 
the PDF and those in the data file 
exactly match. 

 
 Note: Data files must have the field 

names in the first line of the file. 
 
The “Export Field Names” function is particularly useful when the user does not know the 
field names used in the Acrobat document, or when there are a large number of field 
names and comparing them with the field names in the data file would otherwise be 
difficult. This function allows the user to export the Acrobat form field names to a text file 
so that they can be used to ensure that the field names in the data file match. 
 

8.1 Export Options 
 
• Delimiter: 
 
This list allows the user to select the type of delimiter to be used to separate field names 
in the exported file. Choices are Tab, Comma, Semicolon, or Space 
 
• Qualifier: 
 
This allows the user to specify how field names which contain the selected delimiter are 
to be identified in the exported file. Choice are “None”, “Double-quote(“)”, or “Single-
quote (‘)”. As an example, if a field name contains a comma (last name, first name) and 
the selected delimiter is also comma and no qualifier is chosen, then the exported file 
would treat “last name” and “first name” as two separate fields. By using a qualifier such 
as Double-quote, the exported file would contain “last name, first name” so that they will 
be recognized as a single field. If a field name has the selected delimiter in it and no 
qualifier is selected, ARTS PDF Variform Lite will automatically use a Double-quote 
qualifier so that errors do not occur. 
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9.0 WATCHED FOLDERS 
 
ARTS PDF Variform Lite Watched Folders is a “hot folders” approach to automation. 
First you select an existing folder on your hard disk to act as a watched folder, next 
choose an Acrobat form to associate with the folder, then select a delimiter and your 
output options and you are ready. After everything is set up, make sure that Acrobat has 
been launched, then simply drop data files that you want processed in the appropriate 
watched folder. 
 
 
 
ARTS PDF Variform Lite 
Watched Folders is activated by 

clicking the  icon on the 
Acrobat menu bar. When 
activated, the dialog window will 
display any existing watched 
folders. From this window the 
user may add a new watched 
folder, and edit or remove an 
existing folder. 

 
 
 

 Note: A separate watched folder is required for each Acrobat form which the user desires to 
automate.  

 
The box titled “Watched Folders Active” is used to activate or deactivate the automatic 
processing of data files. When this box is checked and Acrobat is running, any valid data 
file placed in the watched folder will be processed automatically. If the box is unchecked, 
any data files placed in the watched folder will not be processed until watched folders 
are again activated by checking this box. 
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9.1 Watched Folder Setup 
 
 
ARTS PDF Variform Lite will automatically create three folders inside each selected 
watched folder. First is a folder labeled “Success”. This is where data files will be moved 
after they have been successfully processed. Second is a folder called “Output”.  This 
folder will contain the PostScript file(s) from the merge activity if “Print to File” was 
selected. The third folder is named “Error”. This is where any files which fail to process 

will be placed. 
 
When active, ARTS PDF 
Variform Lite constantly scans 
the watched folders. When it 
sees a new data file to be 
processed, it will begin the 
merge process using the 
settings for that watched folder. 
Upon completion, the data file 
will be moved to the Success 
Folder. If ARTS PDF Variform 
Lite finds a file type other than 
a delimited data file in the 
watched folder, it moves it to 
the Error Folder. Normally 
output is delivered to the 
selected device, but for “Print t
File”, the resultant output file is 
delivered to the Output Fol
 

o 

der. 

 the user wishes to use ARTS 

 

ation. 

 ARTS PDF Variform Lite Watched Folders is intended to automate the merging of a complete 

te. 
 

If
PDF Variform Lite directly (non-
automated), he may do so at 
any time. This direct control by
the user only temporarily 
suspends automated oper

 
 
 

set of records to all pages of a PDF form. Therefore, there are no settings for specifying a 
range of records or pages when using watched folders to automate ARTS PDF Variform Li

  ARTS PDF Variform Lite 1.3 
Page 18 of 19  Copyright © 2004 ARTS PDF 



  ARTS PDF Variform Lite  
 

 

10.0 TROUBLESHOOTING 
 
Before contacting us please check the ARTS PDF Variform Lite conference at the ARTS 
PDF Forum on our web site at: http://forum.artspdf.com
 
If you have no luck there, please e-mail techsupport@artspdf.com and supply the 
information below to help us replicate the problem you are experiencing. 
 

a. The exact version of ARTS PDF Variform Lite you are using (this is 
located by running ARTS PDF Variform Lite, and then clicking Help → 
About Third-Party Plug-Ins → ARTS PDF Variform Lite). Please also 
specify whether you are using a demo or full registered version.  

b. Whether or not you purchased Maintenance with ARTS PDF Variform 
Lite. If you did purchase Maintenance, please supply your ARTS PDF 
Variform Lite serial number.  

c. The exact version of Adobe Acrobat you are using (this is located by 
running Adobe Acrobat, and then clicking Help → About Acrobat).  

d. Whether you are running it on a PC or Macintosh and the exact version of 
the Operating System you are using.  

e. The amount of free disk space remaining.  
f. The CPU speed and amount of RAM for the system on which ARTS PDF 

Variform Lite is running (e.g. Pentium 233 MMX, 32MB RAM). 
g. Any other programs that are running at the time of the error (e.g. Outlook, 

Internet Explorer, etc).  
h. All error messages that were displayed when the error occurred.  
i. The exact series of steps that led to the error.   

 
 
 
 
Feedback If you have ideas and suggestions on how we could improve ARTS 

PDF Variform Lite, we would love to hear your thoughts. Please send 
them to info@artspdf.com
 

Legal Notes  
 

“Adobe” and “Acrobat” are either registered trademarks or 
trademarks of Adobe Systems Incorporated in the United States 
and/or other countries. “Windows” is a registered trademark of 
Microsoft Corporation in the United States and other countries. 
ARTS PDF Variform Lite is Copyright © ARTS PDF 2004. 
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